<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOGO! app</td>
<td>1</td>
</tr>
<tr>
<td>Making basic settings and establishing a connection to LOGO!</td>
<td>2</td>
</tr>
<tr>
<td>Using the device overview</td>
<td>3</td>
</tr>
<tr>
<td>Creating controls</td>
<td>4</td>
</tr>
<tr>
<td>Settings and project information</td>
<td>5</td>
</tr>
</tbody>
</table>
Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

| WARNING | indicates that death or severe personal injury may result if proper precautions are not taken. |
| CAUTION | indicates that minor personal injury can result if proper precautions are not taken. |
| NOTICE  | indicates that property damage can result if proper precautions are not taken. |

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

| WARNING | Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed. |

Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
Table of contents

1 LOGO! app ...........................................................................................................................................5
  1.1 Function overview.......................................................................................................................5
  1.2 Downloading the LOGO! app.......................................................................................................6
  1.3 LOGO! app icons...........................................................................................................................8

2 Making basic settings and establishing a connection to LOGO!.....................................................11
  2.1 Specify access of the app in LOGO! Soft Comfort......................................................................11
  2.2 Starting the app and specifying a password..............................................................................13
  2.3 Setting up the connection to the LOGO! controller.................................................................14

3 Using the device overview...............................................................................................................19
  3.1 Displaying the IO status of inputs/outputs, bit memories and keys........................................20
  3.2 Displaying and changing tags in the controller.........................................................................24
  3.3 Outputting the IO status and tag status via the trend view......................................................26
  3.4 Setting date/time.........................................................................................................................29
  3.5 Working with the Web server.......................................................................................................29

4 Creating controls............................................................................................................................33
  4.1 Control overview.........................................................................................................................33
  4.2 Adding a control button..............................................................................................................34
  4.3 Adding a control slider................................................................................................................35
  4.4 Adding control bars....................................................................................................................36
  4.5 Adding a control output field......................................................................................................36
  4.6 Adding a gauge control...............................................................................................................37

5 Settings and project information...................................................................................................39
  5.1 Change language.........................................................................................................................39
  5.2 Refresh frequency.........................................................................................................................39
  5.3 Changing your password.............................................................................................................40
1.1 Function overview

The application enables the user to connect to a LOGO! 0BA7 or LOGO! 0BA8 via WLAN or Internet using a smart device.

Functions of your LOGO! app

- Configuring a control page for operator control and monitoring of tags with configurable control types: Gauge, switch, bar graph, output field and slider. One control from each control type can be configured free of charge. If you require additional control of a type, these must be activated once by means of an in-app purchase. After the activation, as many controls of the relevant type as required can be configured. The maximum total number of controls is limited to 50.

  NOTE: An Internet connection must be established in order to add controls to the control page. It is possible to use the controls without an Internet connection.

- Displaying the operating mode of the controller
- Displaying the IO status
- Displaying and acknowledging the diagnostic buffer
- Displaying Web pages on the Web server (only 0BA8)
- Monitoring and changing tags in a list (max. 20)
- Displaying up to eight tags in the trend view
- Languages: English and German
1.2 Downloading the LOGO! app

Installation of the app in iOS

You need at least iOS version 7.0 to use the LOGO! app.

Open the following link or scan the QR code:
1.2 Downloading the LOGO! app

Installation of the app in Android

You need at least Android version 4.0 to use the LOGO! app.

Open the following link or scan the QR code:

Download link - LOGO! app iOS (siemens.com/app15)

Download link - LOGO! app Android (siemens.com/app16)
1.3 LOGO! app icons

Overview - Icons in the LOGO! app

Refer to the following table to find out which functions the icons used in the LOGO! app have:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="edit.png" alt="Edit" /></td>
<td>Edit</td>
<td>Edit existing objects (e.g. tags).</td>
</tr>
<tr>
<td><img src="copy_paste.png" alt="Copy and paste" /></td>
<td>Copy and paste</td>
<td>Create a copy of the selected object.</td>
</tr>
<tr>
<td><img src="wrench.png" alt="Wrench" /></td>
<td>Wrench</td>
<td>Change the configuration of the app or a controller.</td>
</tr>
<tr>
<td><img src="plus.png" alt="Plus" /></td>
<td>Plus</td>
<td>Add objects</td>
</tr>
<tr>
<td><img src="cross.png" alt="Cross" /></td>
<td>Cross</td>
<td>Delete objects</td>
</tr>
<tr>
<td><img src="move.png" alt="Move" /></td>
<td>Move</td>
<td>Change the sorting of objects (such as tags) by holding the icon pressed and moving it to the desired location.</td>
</tr>
<tr>
<td><img src="floppy_disk.png" alt="Floppy disk" /></td>
<td>Floppy disk</td>
<td>Save new or edited objects.</td>
</tr>
<tr>
<td><img src="back.png" alt="Back" /></td>
<td>Back</td>
<td>Navigate to the most recently opened dialog in the app.</td>
</tr>
<tr>
<td><img src="share.png" alt="Share" /></td>
<td>Share</td>
<td>Send data from the app.</td>
</tr>
<tr>
<td><img src="trend_view.png" alt="Trend view" /></td>
<td>Trend view</td>
<td>Open trend view. This view displays process values over time.</td>
</tr>
<tr>
<td>Icon</td>
<td>Name</td>
<td>Function</td>
</tr>
<tr>
<td>------</td>
<td>------</td>
<td>----------</td>
</tr>
<tr>
<td><img src="image" alt="End full screen trend view icon" /></td>
<td>End full screen trend view</td>
<td>Ends the full screen view in the trend view.</td>
</tr>
<tr>
<td><img src="image" alt="Trend view standard zoom icon" /></td>
<td>Trend view standard zoom</td>
<td>Reset the zoom within the trend view to the standard setting.</td>
</tr>
<tr>
<td><img src="image" alt="Full screen trend view icon" /></td>
<td>Full screen trend view</td>
<td>Starts the full screen view in the trend view.</td>
</tr>
<tr>
<td><img src="image" alt="Information icon" /></td>
<td>Information</td>
<td>Display information about the app.</td>
</tr>
</tbody>
</table>
1.3 LOGO! app icons
Making basic settings and establishing a connection to LOGO!

2.1 Specify access of the app in LOGO! Soft Comfort

Introduction

Before using the access via the LOGO! app, you need to grant access permission in the respective LOGO! controller and specify a password for this access.

You must make these settings in LOGO! SoftComfort V8 and load them to LOGO!.

Procedure

1. In LOGO!Soft Comfort V8, go to **Tools > Transfer > Access control**.

2. Under "Interface", select your connection to LOGO!.

3. Under Ethernet, enter the IP address of your LOGO!. For dynamic DNS, use the configured URL address.
4. Press **Test** to check if the connection was established successfully. If the connection was successful, press **OK** to load the program to the device.

5. Under **File > Properties**, go to the menu item "Access control settings", **Online settings** tab.
   - Select the check box for **Allow LOGO! App access**.
   - Select the check box for **Enable password protection for LOGO! App access**.
   - Assign a password. This password does not have to be the same as the password for the LOGO! connection. You assign the password for the LOGO! connection later on in the app.
   - Click **Apply** to apply the password.
6. If you want to access the Web server with the LOGO! app, select **Allow Web server access** and assign a password.

7. Load the settings to the controller.

### 2.2 Starting the app and specifying a password

**Introduction**

The first time the app is started, you can set a password to use the app. The password is only used to log onto the LOGO! app. You can define the access to the respective LOGO! controller in the device overview.
Procedure

The first time the LOGO! app is used, the following mask appears in which you can specify a password for the LOGO! app.

1. Assign a password and confirm with Save.

2. If you do not want to assign a password for the app, enter nothing and simply click Save.

Result

The password is required each time you open the app. The password can also be subsequently set or changed in the "Settings" mask.

2.3 Setting up the connection to the LOGO! controller

Requirement

Access through the LOGO! app was permitted in LOGO! Soft.

If you want to access the Web server using the LOGO! app, you must permit Web server access in LOGO! Soft.
The port forward for port 8080 must be activated in the router of your network.

Core statement

1. Click on the **plus symbol** in the device overview. The "Create Connection" dialog opens.
2. Select the type of your LOGO! controller (0BA7 or 0BA8).
3. In the "Name" field, enter a name with which the connection is displayed in the app. The name can be freely assigned.
4. Under "IP Address / Hostname" and "Port", enter the connection data to the controller.
5. If you want to control the Web server using the app (only with 0BA8), enter the Webserver user name and the password.

6. Click on the floppy disk icon to save the connection data.
Result

The controller is displayed in the device overview. Click on the controller to establish the connection.
Making basic settings and establishing a connection to LOGO!

2.3 Setting up the connection to the LOGO! controller
Using the device overview

Starting point of the functions

The "Station Info" provides access to the following functions:

- View status of inputs and outputs
- View and change tag values
- Set date and time of LOGO!
- Access to the Web server
3.1 Displaying the IO status of inputs/outputs, bit memories and keys

Output of the I/O status

Under "IO State Selection", you access the status displays of the inputs and outputs, bit memories, LOGO! keys and text display.
3.1 Displaying the IO status of inputs/outputs, bit memories and keys
Example: Output of inputs

Click Inputs in the "IO State Selection". The output of the inputs is started automatically in the app.

- You can view newer or older process values by swiping down and up.
- You can show the other inputs by swiping left.

The set update rate determines how frequently the inputs are written. See also: Refresh frequency (Page 39)
### 3.1 Displaying the IO status of inputs/outputs, bit memories and keys

<table>
<thead>
<tr>
<th>Time/Date</th>
<th>I1</th>
<th>I2</th>
<th>I3</th>
<th>I4</th>
<th>I5</th>
</tr>
</thead>
<tbody>
<tr>
<td>13:47:33</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>13:47:32</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>13:47:31</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>13:47:30</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>13:47:29</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>13:47:28</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>13:47:27</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>13:47:26</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>13:47:25</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
3.2 Displaying and changing tags in the controller

Digital and analog network inputs

You can address digital and analog network inputs directly with the respective V address in the LOGO! app.

Analog FB parameters

To display or change analog FB parameters in the LOGO! app, you must enter these FB parameters in the parameter VM table in LOGO! Soft Comfort (menu item "Tools > Parameter VM Mapping") FB Parameters - Read only (actual value in LOGO!) FB Parameters - Read and write
Calling tags in the LOGO! app

1. In the "Station Info" mask, select “Tags” and click the plus symbol.
2. The "Add Tag" dialog opens. Enter the following data:
   - **Address**: The address corresponds to the V address of your network input or FB parameter in the LOGO! program.
   - **Name**: Enter any name for the tag. The name is used only for display in the app.
   - **Format**: Under Format, select the display format of the tag. For digital tags, select "BINARY"; for analog tags, select the required display format, e.g. "UNSIGNED".
3. Click on the floppy disk icon to save the tag.

The tag is displayed in the tag list. In the tag list, you can create a maximum of 20 tags for one LOGO!.

![Edit Tag](image)
Changing the tag value

1. In the tag list, click on the tag with the value you want to change. The “Change value on PLC” dialog opens.
2. Enter the desired value under "New Value".
3. When you tap the “Write to LOGO!” button, the value from LOGO! is applied as the current tag value.

3.3 Outputting the IO status and tag status via the trend view

Introduction

Using the "Trend view" you can display the value changes of the IO status (inputs, outputs, etc.) and the tag over time.

A maximum of 8 tags can be displayed in the trend view at the same time. The supported data types are BIN, SIGNED, UNSIGNED and HEX.

- If you use the trend view to output the IO status, select the addresses of the inputs, outputs etc.
- If you use the trend view to output tags, select the tags from the tag list.
Open the trend view

1. Click on the trend view icon in the tag list below in the dialog.
2. Use the check boxes to select the tags that you want to output via the trend view. Trend view starts as soon as you select the option for the tag.
3. Click on the arrow icon at the upper right to start the trend view in full screen mode.

Result

The value changes of your selected tags over time are displayed.

- By moving the blue slider to the left or right, you can display the tag values read.
- The exact values for the position of the slider are displayed below the coordinate system.
- You can use gestures to zoom in and out and use the standard zoom symbol to restore the original view.

How frequently a new value is written depends on the refresh frequency. You can adjust this in the app settings.
3.3 Outputting the IO status and tag status via the trend view
3.4 Setting date/time

Date and time

You can set the date and the time individually using the "Set Clock on PLC" selection in the Station Info.

![Set Clock on PLC](image)

3.5 Working with the Web server

Logging on to the Web server

Open the Web server via Station Info, enter the name and the password for Web server access, and click Log on.

You can open the following Web server functions from the drop-down list:

- LOGO! system: System overview
- LOGO! tag: Displaying and changing tags
3.5 Working with the Web server

- LOGO! BM: Controlling the LOGO! basic module
- LOGO! TD: Reading out the LOGO! text display

![WebView Log on form](image)
LOGO! system

You read out the device data of your LOGO! via the system overview.

System

<table>
<thead>
<tr>
<th>Device Series</th>
<th>0BA8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Type</td>
<td>12/24RCE</td>
</tr>
<tr>
<td>FW Version</td>
<td>V1.08.02</td>
</tr>
<tr>
<td>IP Address</td>
<td>192.168.2.1</td>
</tr>
<tr>
<td>Status</td>
<td>Running</td>
</tr>
</tbody>
</table>
3.5 Working with the Web server

Editing a LOGO! tag

You read out the tags of your LOGO! and change the tag values under "Edit LOGO! tag".

LOGO! BM and LOGO! TD

The functions LOGO! BM and LOGO! TD will only be available as of the next app version:

- The display messages of the LOGO! basic module are output under "LOGO! BM" over the Web server.
- The contents of the text display can be output under the LOGO! TD option.
Creating controls

4.1 Control overview

How controls work

Controls are graphical control elements for reading and writing PLC tags. You can configure up to 50 controls in your LOGO! app.

Controls are always linked to a tag whose value is to be changed or output via controls. The list of controls can include multiple controllers and their tags.

Enabling controls

For testing purposes, you can use a given control of any type once free of charge. Thereafter, activation of the control type is subject to charge.

Once you have activated a control element, you can use this type in your app as often as you like.

The activation of the control type is stored in your app store under your account. When you change the device, you can continue to use the control type at no additional cost.

Requirement

To use a control, you must have previously created a tag for LOGO!.

See also: Displaying and changing tags in the controller (Page 24)

Control types

There are five different controls that you can use:

- **Button**: For switching between two values of a tag
- **Slider**: For changing analog values
- **Bars**: Output of analog values
- **Output field**: Output of analog values
- **Gauge**: Output of analog values with indication of critical value ranges
4.2 Adding a control button

Example: Control button

One use for the control button is an on/off switch for a motor.

Adding controls

1. Click on the plus symbol on the control page.
2. Select the control button.
3. Enter the following information under "Edit button":
   - **Edit control name**: Name under which the control is shown in the app. The name of the control is independent of the tag name.
   - **Name left / right**: Label in the app for the left and right button of the control
   - **Select PLC**: Selection of the CPU that contains the tag for the control.
   - **Target Tag**: Tag to be displayed and controlled via the control.
   - **Value left / right**: Value to be written by the left or right button.
   - **Shows indicator field (optional)**: The indicator field outputs the value of a tag.
   - **Current tag**: Tag in the controller whose value is to be output.
   - **Text in indicator field**: Text to be displayed for a given tag value (for example, "Motor off" for tag value "0").
   - **Value for text**: Tag value.
4. Click on the floppy icon at the upper right to save the control.

Result

The control is displayed on the control page. You can use the icon to the right of the control to edit, delete or duplicate the control.
4.3 Adding a control slider

Example: Control slider

One use for the control slider is changing a fill level or speed (change of analog values).

Adding controls

1. Click on the plus symbol on the control page.
2. Select the "Slider" control.
3. Enter the following data under "Edit slider”:
   - **Edit control name**: Name under which the control is shown in the app. The name of the control is independent of the tag name.
   - **Min./Max. Value**: Value range that can be written using the slider. If the process value violates the value range, an arrow is shown to the right or left of the slider.
   - **Select PLC**: Selection of the CPU that contains the tag for the control.
   - **Target Tag**: Tag to be displayed and controlled via the control.
   - **Select Auto scaling / Number of segments**: Specify whether the slider is to be divided into a fixed number of segments or if the app should set the number of segments automatically.
   - **Show current value**: The current value is displayed next to the slider. The tag for the current value does not correspond to the target tag in this case.
4. Click on the floppy icon at the upper right to save the control.

Result

The control is displayed on the control page. You can use the icon to the right of the control to edit, delete or duplicate the control.
4.4 Adding control bars

Example: Control bars

One use for the control bar is displaying a fill level or speed (display of analog values).

Adding controls

1. Click on the plus symbol on the control page.
2. Select the “Bar” control.
3. Enter the following data under “Add bar”:
   - Add control name: Name under which the control is shown in the app. The name of the control is independent of the tag name.
   - Min./Max. Value: Value range that can be written using the slider. If the process value violates the value range, an arrow is shown to the right or left of the bar.
   - Select PLC: Selection of the CPU that contains the tag for the control.
   - Target Tag: Tag to be displayed and controlled via the control.
4. Click on the floppy icon at the upper right to save the control.

Result

The control is displayed on the control page. You can use the icon to the right of the control to edit, delete or duplicate the control.

4.5 Adding a control output field

Example: Control output field

Any type of value can be displayed via the output field. One use for the output field control is to output a status value of an instruction.
Adding controls

1. Click on the plus symbol on the control page.
2. Select the control in the output field.
3. Enter the following information under “Edit button”:
   - **Edit control name**: Name under which the control is shown in the app. The name of the
     control is independent of the tag name.
   - **Select PLC**: Selection of the CPU that contains the tag for the control.
   - **Target Tag**: Tag to be displayed and controlled via the control.
4. Click on the floppy icon at the upper right to save the control.

Result

The control is displayed on the control page. You can use the icon to the right of the control

to edit, delete or duplicate the control.

4.6 Adding a gauge control

Example: Gauge control

One use for the gauge control is to display the speed for a motor.

![Current Speed](image)

Adding controls

1. Click on the plus symbol on the control page.
2. Select the control in the output field.
3. Enter the following information under "Edit button":

- **Edit control name**: Name under which the control is shown in the app. The name of the control is independent of the tag name.
- **Title**: Text that is displayed in the control itself (for example: "Speed" or "km/h").
- **Min./Max. Value**: low and high values of the displayed scale. If the process value violates the value range, an arrow is shown to the right or left of the pointer instrument.
- **Start value warning / start value danger**: Value as of which the scale is highlighted in yellow or red.
- **Select PLC**: Selection of the CPU that contains the tag for the control.
- **Target Tag**: Tag to be displayed and controlled via the control.

4. Click on the **floppy icon** at the upper right to save the control.

**Result**

The control is displayed on the control page. You can use the icon to the right of the control to edit, delete or duplicate the control.
Settings and project information

5.1 Change language

Language selection

1. Open settings of the app on the start screen by clicking on the wrench icon at the bottom left.
2. Click Language selection.
3. Select your language (English or German).
4. Click on the floppy icon at the upper right to save the settings.

Result

The language of the app has been switched.

Note that the language switch only affects the app. Project texts from TIA such as diagnostic buffer entries are displayed in the configured project language of the controller.

5.2 Refresh frequency

Refresh frequency

You use the refresh frequency to determine how often a process value is to be read from the controller.

Set the refresh frequency

1. Click Refresh frequency on the "Settings" page.
2. Select the refresh frequency between 0.5 and 30 seconds.
3. Save the refresh frequency with floppy icon at the upper right.

Result

The display of the values in the tag list, the trend view or in the controls are updated according to the selected setting.
5.3 Changing your password

Password protection of the S7 app

The S7 app itself can be protected by a password. The password protection prevents unauthorized access to the controller via the app.

When you first start the app, you can optionally assign a password:

- If you skipped this step, you can use the "Change Password" dialog at any time to assign a password.
- If you have already assigned a password, you can change or delete your password via the dialog.

Setting a password

1. Leave the "Old password" empty.
2. Enter your desired password for the app under "New password".
3. Enter and confirm the new password and click Save.

Changing your password

1. Enter your password in the "Old password" field.
2. Enter your desired password for the app under "New password".
3. Enter and confirm the new password and click Save.

Delete password

1. Enter your password in the "Old password" field.
2. Leave the other two fields empty and click Save.